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Overview 
This documentation is intended to show you how to edit your website using the Content Management 

System.  A content management system refers to any software that you use to update and maintain 

content on your website.  In the Web Design industry, this term is commonly abbreviated “CMS” and 

pronounced C-M-S. 

To access the CMS, you will need to use your Web browser.  The minimum browser requirements are: 

 Internet Explorer 7+ 

 Firefox 3+ 

 Google Chrome (any version) 

 Safari 3+ 

 Opera 9+ 

To determine which browser and version you are using, navigate to the Help menu of your browser and 

look for the About option.  If necessary, you can download any of the aforementioned browsers from 

their manufacturers’ websites for free.  

Accounts & Authentication 

Logging in 

To access the CMS, you will need to have your email address and password available.  If you have not yet 

received your password by now, contact your designer. 

Using your browser, navigate to the following Web address: 

 

http://edit-content.com/ 

 

You will see the following login form: 
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Simply enter your email address in the Email field and your password in the Password field to login.  

Note that passwords are case sensitive.  Once you have entered this information, select Login. 

Setting your language preference 

You can select a different language by choosing one from the dropdown control.  Your preference will be 

saved only on the computer you are currently using.  If you use another computer, or if someone using 

your computer changes the language preference, you will need to set it again the next time you login. 

Once logged in, you can also change your language preference from within My Account > Preferences. 

Resetting Your Password 

If you have forgotten your password, select the Forgot Password link at the bottom of the login form.  

You can reset your password by providing your email address and a 5-letter security code.  A new 

temporary password will be sent to your email address immediately. 

Once logged into the CMS, you can change your temporary password by going to My Account > 

Change Password. 

Websites 
The Websites section is where you can view and select which website you would like to edit.  If you only 

have one website, you will be automatically taken to the Webpages section. 

Selecting your website 

For editors who have access to more than one website, you will see the following screen. 

 

To select the website that you would like to work with, simply click on the appropriate domain name.  For 

example, to edit a webpage under example-1.com, you would click on example-1.com. 
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Webpages 
The webpages section displays each webpage that your designer has enabled for editing.  Depending on 

your account settings, you may see different options than what is shown below. 

 

Selecting a webpage 

To begin editing one of your webpages, select the appropriate label from the list.  For example, if you 

wanted to edit your homepage, select the Homepage label by clicking on it. 

Changing page labels 

You can change the label of each webpage by selecting the Edit Label option.  These labels are only used 

within the CMS to reference your pages, so feel free to use anything that helps you to remember which 

page is which. 

Once you select the Edit Label option, a textbox will appear allowing you to change the label.  When you 

are finished editing, press Enter or click anywhere outside of the textbox to save your changes. 

Cloning webpages 

You can quickly and easily create new pages by cloning, or duplicating, existing pages.  When you clone 

a page, an exact copy of the page you are cloning will be created.  To clone a page, follow these steps: 

1. Select the Clone option. 
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2. Enter a file name for the new file that you are creating. It is usually best to use lowercase 

characters and dashes for webpage filenames.  The CMS will automatically turn spaces into 

dashes for usability purposes. 

3. Select the Create New Webpage button. 

4. The new page will be displayed below the existing page. 

 

Once your new page is created, be sure to update the webpage title, description, and keywords to ensure 

that search engines index it properly.  Refer to the Page Properties section for more information about 

this feature.  

Note: Depending on your account settings, the clone feature may not be available. 

Deleting webpages 

You can remove old or unwanted pages by selecting the Delete option.  You will be prompted to confirm 

your choice.  Select Delete to permanently delete the webpage, or Cancel to abort the operation. 

 

Note: Depending on your account settings, the delete feature may not be available. 

Webpage Editor 

Selecting a content region 

Although each webpage will vary, it is possible for your pages to have multiple content regions.  If your 

pages have more than one content region, you can switch between them using the Content Toolbar: 

 

Each button on the Content Toolbar represents a unique content region.  This toolbar may vary from page 

to page, and will probably look different than the one pictured above.  To select one of the content 
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regions, simply click on the appropriate button in the toolbar.  You can switch back and forth between 

content regions on the same page without having to save your changes. 

Types of content regions 

There are a handful of different types of content regions available in the CMS.  The most common is by 

far the rich-text editor, but depending on how your website was setup, you may come across any of the 

following: 

Rich-text 

This is the default content region type.  See the Rich-text editor section below for more details. 

Headings 

This type of content region only allows you to change the text in a heading (H1, H2, H3, H4, H5, H6). 

Images 

This type of content region allows you to edit a single image.  You can edit the image, upload a new one, 

or change the image description. 

Plain-text 

This type of content region only allows you to use plain-text. 

Source code 

This type of content region is for advanced users who need to work with CSS, JavaScript, or XML files. 

The rich-text editor 

You will likely spend most of your time editing your website using the rich-text editor.  The following is 

a screenshot of the rich-text editor with all options enabled.  Your version of the editor may be simplified 

depending on your account settings. 
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Working with the rich-text editor is very similar to working with popular word processing applications.  

The following sections will go over some of the basics as well as some of the more advanced features, 

such as structuring your content, creating hyperlinks, and working with images. 

Undo & Redo 

The undo and redo buttons allow you to step through your changes while editing.  

 

Basic formatting 

As in many popular word processing applications, you can change the format of text by selecting one or 

more characters and clicking on the appropriate formatting option.  For example, to make text bold, select 

the appropriate text and click on the B in the toolbar.  Similarly, to make text italic, select the appropriate 

text and click on the I in the toolbar.  Depending on your account settings, you can also choose underline, 

strikethrough, subscript, and 
superscript

. 

 

A note about using underlined text on webpages:  Most users expect underlined text on webpages to be 

hyperlinks.  Therefore, it is generally considered a bad practice to use such formatting on webpages, as it 

could easily confuse users and make them think your website is “broken” because your “links” do not 

seem work. 
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Text Alignment 

You can choose to align your text left, center, right, or justified using the respective buttons in the rich-

text editor toolbar.  To do this, click inside of a paragraph (or highlight multiple paragraphs) and select 

the appropriate option from the toolbar. 

 

Structuring Your Content 

The Format dropdown allows you to structure your document using 

paragraphs, headings, and other types of content sections.  These content 

sections help keep your webpages organized.  Since search engines deliver 

results based on relevancy, it is important to structure your webpages properly 

and use these content sections properly whenever possible, especially headings. 

The default type of content section is paragraph.  You can create a heading by 

selecting a line of text and choosing one of the heading options from the 

Format dropdown.  To turn a heading back into a paragraph, select the 

appropriate text and choose Paragraph from the Format dropdown. 

For best results, refrain from using Headings strictly for style.  For example, if you want to emphasize a 

sentence it is usually not a good idea to do so by making it a Heading 1.  See the section on Custom 

Styles or Text Formatting or more information on how to properly format text. 

Text Formatting 

To change the appearance of text, including the font size, foreground, and background color, you can use 

the following toolbar options.  Simply select the text that you would like to format and choose the 

appropriate size and colors.  

 

Custom Styles 

Your designer may provide you with custom styles to use in your webpages.  If these 

styles are available, you will find them under the Styles dropdown. 

These styles will vary in both name and appearance, depending on how your 

designer has configured them.  If they are available to you, you can apply one or 

more styles to your content by selecting some text, clicking the Styles dropdown, 

and choosing the style you want.  To apply multiple styles to the same content, select 

each style from the Styles dropdown one at a time. 

To remove a style, select the appropriate text, click the Styles dropdown, and select the style again from 

the list. 
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Hyperlinks 

To create a hyperlink, or “link”, to a webpage or file, you can use the Insert/Edit Link tool.  There are 

two toolbar buttons for working with links.  The first one allows you to create links in your content and 

the second one allows you to remove links from your content. 

 

To create a link, select the text that you would like to make a link and click on the Insert/Edit Link 

button.  The following dialog will appear. 

 

The Link URL is simply the location of the webpage, document, or other resource on the Web.  A URL 

usually looks something like this: http://example.com/path/to/filename.ext 

If you are linking to a webpage or file outside of your website (on another website, for example), you will 

need to copy and paste the URL into the Link URL field.  You can usually copy URLs directly from the 

address bar in your browser. 

For webpages and files inside of your website, you can use the File Manager to populate the Link URL 

field.  For more information on working with the File Manager, please refer to the File Manager section. 

To remove a link, highlight the linked text and select the Unlink button. 

Linking to anchors on the same page 

It is possible to link to various sections of a webpage by using anchors.  You can create an anchor by 

placing the text cursor somewhere in your content and selecting the Insert/Edit Anchor tool. 

 

The resulting dialog will allow you to specify a name for your anchor. 
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Note: For maximum compatibility in various web browsers, anchors should always begin with a letter 

and use only the following characters: A-Z, a-z, 0-9, underscore, and dash. 

Once you have entered a name for your anchor, select the Insert button to place it in your content.  The 

anchor will be placed in the current position of the text cursor. 

 

To create a link to this section of the webpage, use the Insert/Edit Link tool. 

 

The following dialog will appear.  From here, you can select the anchor from the Anchors dropdown 

menu. 
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Once you have selected the appropriate anchor, select Insert to create the link in your content. 

To remove an anchor link, highlight the linked text and select the Unlink button. 

Lists, Blockquotes, and Indentations 

The rich-text editor allows you to create bulleted (unordered) or numbered (ordered) lists, indent sections 

of your content, and create blockquotes very easily. 

 

To create a list, select either the Unordered List or the Ordered List button from the toolbar.  You can 

choose to create a new list by placing the text cursor inside of an empty paragraph or you can select some 

text and turn your entire selection into a list. 

To create a sub-list, highlight one or more list items and select the Indent button from the toolbar.  You 

can use the Outdent button to remove a sub-list. 

To remove a list completely, highlight the entire list and select the appropriate list button from the 

toolbar.  This will convert the list to paragraph form. 

To create a blockquote, highlight a section of text and select the Blockquote option from the toolbar. 

To remove a blockquote, highlight an existing blockquote and select the Blockquote option from the 

toolbar.  The content will return to the default paragraph form. 

Inserting / editing images 

To insert an image into your content, place the cursor where you would like the image to appear in the 

document and select the Insert/Edit Image button.  Similarly, to edit an existing image, click on the 

image once and then select the Insert/Edit Image button. 
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The following dialog box will appear: 

 

You can either type the URL of the image into the Image URL field, or browse the server by selecting 

the Yellow Folder icon pictured above.  (For more information about browsing the server, please refer to 

the section entitled File Manager.) 

The Image Description field serves as the alt text, or alternate text, which is shown to individuals who 

have images disabled in their web browser.  It is important to make the Image Description descriptive yet 

concise.  Although this field is optional, it is a good practice to populate it whenever possible. 

The Title field serves as the image’s title attribute.  In most browsers, when a user hovers over the image, 

they will be shown a tooltip containing the text that has been set in the title attribute.  In addition, many 

photo galleries (such as Lightbox) use the title attribute as a caption. 

You can change the alignment, dimensions, and other image attributes using the Appearance tab. 
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Alignment will tell the browser where to place the image in reference to the existing content.  You can 

see a preview of how your image might appear in line with text in the preview on the right. 

Dimensions tell the browser how wide and tall to draw the image.  The first field is always width and the 

second field is always height.  These attributes are always set in pixels.  If you select Constrain 

proportions, the image will maintain its original aspect ratio as you adjust the width and height. 

Note: Reducing the width and height in this dialog does not reduce the overall size of the image.  To scale 

down an image and reduce the file size (allowing it to load quicker for users), please refer to the Image 

Editor section of this documentation. 

Inserting documents (DOC, PDF, XLS, PPT, etc.) 

To insert a document into your content, place the cursor where you would like to document to be linked to 

and select the Insert Document button from the toolbar. 

 

The Document Manager will appear, allowing you to select a file to insert into your content.  For more 

information about navigating the Document Manager, please refer to the File Manager section of this 

documentation. 
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Once you’ve selected the file that you want to insert, a link will appear in your content.  By default, the 

link text will be filename.ext (replace filename and ext with the appropriate filename and extension of the 

selected file).  You can change the link text to whatever you like, so long as the link remains intact. 

Inserting / editing media (Flash, videos, etc.) 

To insert a media element into your content, select the Insert/Edit embedded media button from the 

toolbar.  Similarly, to edit an existing media element, click on the element once and then select the 

Insert/Edit embedded media button. 

 

The following dialog box will appear: 

 

Select the type of media element from the Type dropdown, and then fill in the File/URL field.  If you 

don’t know the URL, you can browse the server by selecting the Yellow Folder icon pictured above.  

(For more information about browsing the server, please refer to the section entitled File Manager.) 
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You can set the width and height of the media element by filling in the Dimensions field.  The first field 

is always width and the second field is always height.  Width and height are always measured in pixels. 

For advanced media options, select the Advanced tab.  Depending on the type of media you are 

embedding, the options will vary. 

Webpage properties 

If this option has been enabled, you can modify each page’s title, description, and keywords.  These fields 

are commonly used for Search Engine Optimization (SEO) techniques, so your designer may have 

already optimized them for you.  You should talk to your designer before making any changes if you are 

unsure about modifying any of the following properties.  

To access the Webpage Properties of one of your pages, select the Properties tab from within the 

Webpage Editor: 

 

Webpage Title 

The Webpage Title usually appears in your browsers title bar and is usually shown in search engine 

results, as demonstrated in the image above.  Try to keep your titles relevant, descriptive, and concise.  

Excessively long titles are usually truncated, especially in search engine results. 

Description 

The Webpage Description is usually a sentence or two that describes your page to potential visitors.  

Many search engines use this to display a short snippet or overview of your page in their results.  Again, 

try to keep this relevant to your page’s content.  Descriptions that are too long usually get truncated by 

search engines.  

Keywords 

Keywords should be a list of comma-separated words and phrases that relate to the content of your 

website, especially in relation to the current page.  You can add as many keywords as you like, but three 

to five is usually sufficient.  
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Search engine preview 

This feature will give you an idea of how your webpage might appear in the results of popular search 

engines.  As you type, the preview will update automatically.  The preview even truncates excessively 

long titles and descriptions, but there is no guarantee as to how different search engines will actually 

index your pages. 

View Current, Preview & Publish 

This section discusses the following three buttons that appear at the bottom of the Webpage Editor: 

 

View Current opens a new window and shows the current webpage as it appears on the Web. 

Preview allows you to see your changes exactly as they will appear once published.  The preview opens 

in a new window so your changes will not be lost. 

Publish to Web published the webpage to the server, making it live immediately.  After publishing, you 

can verify that your changes have been saved by using the View Current button.  (You may need to 

refresh your browser if you do not see your changes immediately. Windows users can use CTRL + R; 

Mac users can use CMD + R.) 

Webpage History 

The CMS retains a copy of every page published for up to 90 days.  By selecting the History tab from 

within the Webpage Editor, you can access a full list of revisions that have been made to the current page. 

 

Selecting View allows you to preview the appropriate revision in a new window.  This option will not 

affect the live website in any way. 
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Selecting Revert allows you to restore the current webpage to the appropriate revision.  This option will 

overwrite the existing webpage with the revision you select. 

File Manager 
The File Manager is used to upload and organize files on your website.  Depending on the way your 

website is configured, your access to the File Manager may vary.  The full-featured version of the File 

Manager is shown below. 

 

Working with folders 

The left-side of the File Manager contains a list of folders that exist on your website.  This is called the 

Folder Column.  

Navigating 

To highlight a folder, click on it one time. 

To open a folder, double-click on it. 

To go one folder higher in the file system, double-click on the One Level Up option.  (You can also use 

the Path Browser above the Folder Column to quickly navigate back to higher folder levels.) 
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Creating new folders 

You can create a new folder by selecting the New button underneath the Folder Column.  After you type a 

name for the folder, press the ENTER key to commit your changes. 

Note: New folders are always created inside of the current folder.  

Renaming folders 

To rename a folder, select it from the Folder Column by clicking on it one time.  Next, select the Rename 

button under the Folder Column.  When you are done renaming the folder, press the ENTER key to 

commit your changes. 

Deleting folders 

To delete a folder, select it from the Folder Column by clicking on it one time.  Next, select the Delete 

button under the Folder Column.  You will be prompted to confirm your action. 

Note: The File Manager will permanently delete all files and folders inside of the selected folder.  Since 

there is no way to undo this action, you should contact your designer and/or create a backup of your 

website before deleting anything! 

Working with files 

The right-side of the File Manager contains a list of files that exist in the current folder on your website.  

This is called the File Column. 

Selecting files 

To highlight a file, click on it one time. 

To select a file, double-click on it or highlight it and then choose the Select File option.  (The Select File 

option only exists in certain versions of the File Manager when selecting a file is necessary.) 

Downloading files 

You can download any file from your website by highlighting it and then selecting the Download button 

underneath the File Column. 

Note: The download feature is not intended to be used as a backup mechanism.  To download a large 

number of files, please ask your designer about obtaining FTP access to your website. 

Renaming files 

To rename a file, select it from the File Column by clicking on it one time.  Next, select the Rename 

button under the File Column.  When you are done renaming the file, press the ENTER key to commit 

your changes. 

Deleting files 

To delete a file, select it from the File Column by clicking on it one time.  Next, select the Delete button 

under the File Column.  You will be prompted to confirm your action. 

Note: The File Manager will permanently delete the file.  Since there is no way to undo this action, you 

should contact your designer and/or create a backup of your website before deleting anything! 
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Uploading files 

To upload a file to your website, follow these steps: 

1. Navigate to the appropriate folder (see Working with folders > Navigating for details) 

2. Select the Upload control at the bottom-left side of the File Manager 

3. Browse your computer and select the file that you wish to upload 

Your upload will begin immediately.  Upon completion, the file will appear at the bottom of the File 

Column.  

Image Editor 
The Image Editor allows you to resize, flip, rotate, and crop images.  You can access the Image Editor in 

any of the following ways: 

 From the File Manager, highlight an image and select the Edit Image button. 

 From the Webpage Editor, select an Image content region and select the Edit Image button (or 

click on the image itself). 

The Image Editor will appear: 
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Resizing 

If you have large photos on your website, you will probably want to resize them using the Image Editor 

so they will load faster for your visitors.  To resize an image, click and drag the Resize handle to the left 

or right. 

Flipping & Rotating 

Use the Flip and Rotate buttons to change the image’s orientation. 

Cropping 

Use the Crop tool to crop a section of the image.  

Trimming 

The Trim button will trim the longest edges of an image to form a perfect square. 

Resetting 

The Reset button will undo all changes since the last save. 

Saving 

The Save option will overwrite the original image file with any changes you have made using the Image 

Editor. 
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If you would rather keep the original image file and save your changes to a new file, use the Save As 

option instead.  If you select this option, you will be prompted to enter a new filename for the image. 

Note: Some browsers may store an old version of the image in their cache.  If you make changes to an 

image and they do not appear on the website, try refreshing your browser (Windows users can use CTRL 

+ R; Mac users can use CMD + R). 

Optional Features 

Google Analytics 

If this feature has been enabled on your website, you will be able to track important information about 

your website’s visitors.  To determine whether or not Google Analytics has been enabled on your 

website, look for the Google Analytics button underneath the list of your website’s pages: 

 

Selecting the Google Analytics button will take you to the Google Analytics dashboard: 
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The Google Analytics dashboard features a chart that tracks visitor trends over a set period of time.  The 

default time period is Last 30 days, and is configurable using the date range dropdown at the top of the 

screen.  You can also see important statistical information at a glance, including visitors, pageviews, 

average time on site, traffic sources, and bounce rate. 

Each tab in the dashboard contains useful traffic information that comes straight from Google Analytics.  

To learn more about how Google Analytics tracks and categorizes visitor information, refer to the Google 

Analytics website: http://www.google.com/analytics/ 

Not enabled for your website?  Talk to your designer today about implementing Google Analytics into 

your website! 

My Account 
Manage your account settings, including name, email address, password, and language preferences from 

the My Account tab. 

Help & Support 
The Help & Support section is designed to expedite help requests to your designer.  When submitting a 

help request, please select the appropriate reason and website and provide as much information as 

possible to help them troubleshoot the problem. 

Your designer will usually respond to your request via email.  Feel free to write back to them by replying 

from within your email client. 

http://www.google.com/analytics/

